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Earth has a circumference of just 
under 25,000 miles. Rotating at 
one revolution per day gives a 
surface speed of over 1,000 miles 
per hour. Earth’s population is 
estimated to be 8,230,000,000. 
Yes, that’s over 8 billion, and  
supposedly we’re only separated 
by 6 degrees? 

Shortly after we were married, we took a weekend trip to St. 
Louis, which included a Cardinals game. We were sitting  
somewhere in the upper deck of the previous Busch Stadium 
amongst a nearly sold-out crowd of over 40,000, only to see a 
high school classmate of mine sitting two rows in front of us. 
What are the odds? 

Twenty-some years ago when the Summer National LICA 
Convention was in Rapid City, South Dakota, we made this a 
family vacation and included our daughters. While touring 
Mount Rushmore, we run into family friends with their kids. 
What are the odds? 

A couple of years ago, my wife “forced” me to go on a two-
week trip to Switzerland, Austria, and Germany. While on top 
of Mt. Pilatus in Switzerland, I ran into a guy wearing a Duke 
Energy coat. I asked him if he by chance worked in Charlotte, 
North Carolina, and if he knew a friend of mine that also 
works there? Not only did he know my friend, but he just so 
happened to be hired at Duke Energy by my friend. What are 
the odds? 

Last January, my wife and I attended the Winter National  
LICA Convention in Jacksonville, FL. We always try to sit at a 
different table during meals to meet new people from around 
the country. It was the last meal of the convention when we 
met Greg and Joan Muenks from Missouri. Greg saw on my 
name tag that I was from Illinois and asked me if I knew where 
Monticello is. I smiled and told him that Monticello is only 
nine miles from our house! He continued by asking me if I 

P R E S I D E N T ’ S  ME S S A G E  

2 0 2 5  B O A R D / M E M B E R S ’  M T G .  A T T E N D A N C E  

A = absent              P = present           C = cancelled meeting 

Area / Director Jan March May July Sep Nov 

Pres: Jon Seevers P P P P   

VP: Tyler Seals P A P A   

1st VP:  LaVerne Weber P P P P   

Area 1 - Brian Brooks P P P P   

Area 1 - LaVerne Weber P P P P   

Area 2 - Steve Anderson P P P P   

Area 2 - Stuart Anderson P P P A   

Area 3 - Grant Curtis A A A A   

Area 3 - Joe Streitmatter P P P P   

Area 4 - David Kennedy A P P A   

Area 4 - Lee Bunting P P P P   

Area 5 - Rick Maguire P P A A   

Area 5 - Earl Mast P A P A   

Area 6 - Scott Day P P P A   

Area 6 - Bill Dean P A A P   

Area 7 - John Barttelbort - - P A   

Area 8 - Tom Beyers A P P P   

Area 8 - Tyler Seals P A P A   

Associate Director:  

Kyle Dentino 
A P A A   

B OA R D  &  M E M B E R S ’  
M E E T I N G  S C H E D U L E  

 

Unless changed by the Board during the year, the ILICA 
business meetings are scheduled as follows: 

 

Sept. 13, 2025 - Regular Meeting of the Board:   

      Virtual & IP - ILICA Office, Galva 
 

Nov. 1, 2025 - Regular Meeting of the Board:   

      Virtual & IP - ILICA Office, Galva 
 

Exact location, meeting times & other details will be published in 
the ILICA News and sent to members via mail and/or email.  

knew a local family farmer that he did an internship with while 
in college during the mid-1970’s. Not only did I know them, 
but their farming operation is only 1 ½ miles from our home, 
and we did a sizeable project for them last year. What are the 
odds? 

A couple of months later, when Greg was headed to Chicago 
for a LICA meeting, we arranged for him and Joan to stop by 
our home and get re-acquainted with his friends that he had 
not seen in nearly a half century. Greg brought an old photo 
album that he had compiled from the summer he spent in 
Central Illinois as an intern. It was fun watching them  
reminisce over the photos and talk about how much things 
have changed over the years. What are the odds?   

Well, the odds increase when you become an engaged member 
of LICA, though the Earth doesn’t spin any slower! 

Jon Seevers 
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June 30, 2025  

WASHINGTON, D.C. — U.S. Transportation Secretary 
Sean P. Duffy today released three sets of landmark revisions 
to the Department’s National Environmental Policy Act 
(NEPA) implementing procedures. These revisions, which cut 
USDOT’s NEPA procedures in half, will slash red tape,  
accelerate major infrastructure projects, minimize delays, and 
curb soaring compliance costs. USDOT has not initiated  
Department-wide NEPA reform in 40 years despite  
widespread agreement that these procedures are inhibiting the 
country from ushering a golden age of Transportation.  
Government-wide reforms in President Trump’s first term 
would have provided much-needed regulatory relief, but the 
Biden Administration reversed those changes. 

“Under President Trump’s leadership, America is building 
again,” said U.S Transportation Secretary Sean P. 
Duffy. “USDOT’s NEPA reforms will make it possible to 
deliver roads, bridges, and other critical infrastructure projects 
faster and more affordably. For too long, unelected  
Washington bureaucrats have weaponized environmental  
reviews to create endless delays and block projects. No more. 
These changes will help usher in a golden age of transportation 
for the American people.” 

These updates combine six separate sets of procedures into 
one unified USDOT Order, providing a one stop shop for 
USDOT NEPA reviews for most of USDOT’s Operating  
Administrations (OAs). Two other sets of revisions include the 
NEPA procedures for FAA, and the procedures used by 
FHWA, FRA, and FTA. Across USDOT, OAs will enforce 
hard deadlines, simplify categorical exclusions, and hone 
NEPA’s focus—clearing the way for robust infrastructure 
growth and a revitalized economy. The effort is part of  
President Trump’s vision to unleash American energy and to 
reshape how these outdated, bloated procedures stop America 
from building great, big, beautiful things across multiple  
federal departments. 

Additional Information: 

The Department released three specific updates to its NEPA 
implementing procedures: (1) Department-wide Order 
5610.1D; (2) Joint FHWA, FRA, and FTA procedures, 23 CFR 
Part 771; and, (3) FAA’s Order 1050.1G. The Department is 
issuing these updates in coordination with the White House 
Council on Environmental Quality in furtherance of the 

U.S .  TR A N S P O RTA T I O N  S E C R E TA RY  U N V E I L S  
S W E E P I N G  U P DA T E S  TO  NEPA TO  F A S T  T R A C K  K E Y  

I N F R A S T RU C T U R E  

Trump Administration’s strategy to simplify the environmental 
review and permitting process and to ensure efficient and 
timely environmental reviews. 

Key changes by USDOT and the other agencies include  
enforceable deadlines and page limits for environmental  
studies, clarifying that NEPA only kicks in when agencies truly 
control a project’s environmental footprint, and streamlined 
“categorical exclusions” that exempt routine, low-impact  
actions from lengthy analysis. The measures will fast-track 
roads, bridges, broadband and energy installations. 

The revisions across USDOT include the following historic 
reforms: 

Implement deadlines and page limits on environmental reviews 
required under recent amendments to NEPA, to expedite  
infrastructure development and reduce costs. 

Provide clarification that NEPA does not apply to every action 
that a Federal agency takes, but only to Federal actions where 
the agency has sufficient control and discretion to take  
environmental effects into account. 

Ensure simple and expeditious processes to create categorical 
exclusions (CEs) (the least burdensome class of action), adopt 
other agencies’ CEs to minimize repetitive NEPA analyses, 
and focus agency attention on actions with truly significant 
environmental effects. 

Prior to this update, some Federal agencies, including parts of 
USDOT, were utilizing NEPA implementing procedures that 
were nearly forty years old. USDOT’s NEPA implementing 
procedures were last revised in 1985. By modernizing the  
environmental review process, USDOT will cut through  
unnecessary layers of bureaucracy in record time, following 
clear guidance to reform the NEPA process set forth in  
President Trump’s Unleashing American Energy Executive 
Order; Congress’ BUILDER Act amendments, as part of the 
2023 Fiscal Responsibility Act, and the Supreme Court’s recent 
landmark decision in Seven County Infrastructure Coalition v. 
Eagle County. 

The U.S. Department of Transportation has long been a leader 
in NEPA reform, and its actions today herald the Trump  
Administration’s decisive action to reform, modernize, and 
expedite the Federal environmental review process and  
eliminate unnecessary delays that are holding back the growth 
of secure and reliable infrastructure projects across the Nation. 

Source: Adapted & reprinted from “U.S. Transportation Secretary Sean P. Duffy 

Unveils Sweeping Updates to NEPA at USDOT to Fast Track Roads, Bridges, & 

Other Key Infrastructure” - https://www.transportation.gov/briefing-room/us-

transportation-secretary-sean-p-duffy-unveils-sweeping-updates-nepa-usdot-fast 

https://www.transportation.gov/briefing-room/us-transportation-secretary-sean-p-duffy-unveils-sweeping-updates-nepa-usdot-fast
https://www.transportation.gov/briefing-room/us-transportation-secretary-sean-p-duffy-unveils-sweeping-updates-nepa-usdot-fast


 

 

Page 7  I l l inois  Chapter  Land Improvement Contractors  of  America  



 

 

Page 8  September  -  October  2025  

October is Breast Cancer Awareness month! Our goal 
throughout the month is to increase awareness of the disease 
and stress the importance of mammograms as the best tool to 
screen for breast cancer, the second most common type of 
cancer among women. Approximately one in eight women in 
the United States will get breast cancer during their lifetime 
and each year, more than 40,000 women die from breast  
cancer.   

Signs and Symptoms of Breast Cancer 

Different people have different symptoms of breast cancer, 
while some do not have any signs or symptoms at all. It is  
important to know how your breasts normally look and feel to 
be able to recognize any changes that may occur. While  
knowing what to look for is important, regular mammograms 
and clinical breast exams are crucial, as these tests can help 
detect breast cancer before symptoms show. 

Signs of breast cancer may include: 

• Lump in the breast or underarm (armpit) 

• Swelling or thickening of all or 
part of the breast 

• Dimpling or skin irritation of 
breast skin 

• Redness, scaliness or thickening 
of the nipple or breast skin 

• Nipple discharge (other than 
breast milk) 

• Any change in the size or shape 
of the breast 

• Pain in any area of the breast 

Get Screened 

A mammogram is a low-dose x-ray picture of the breast. Early 
detection of breast cancer can improve a woman’s chance of 
survival and mammograms are the best tool to find breast  
cancer early, when it is easier to treat and before it is big 
enough to feel or cause symptoms. Women should ask their 
healthcare provider if and when a mammogram is right for 
them.  

How Can I Lower My Risk? 

There are many factors that can influence your breast cancer 
risk such as family history and getting older. There is no sure 
way to prevent breast cancer, but lifestyle changes can help 
lower your risk of breast cancer such as: 

• Keep a healthy weight and exercise regularly. 

• Choose not to drink alcohol, or drink alcohol in  
moderation. 

• If you are taking hormone replacement therapy or birth 

control pills, ask your doctor about the risks. 

• Breastfeed your children, if possible. 

• If you have a family history of breast cancer, be sure to 
talk to your doctor about ways to lower your risk. 

Pink Ribbon Guide 

A pink ribbon symbolizes breast cancer awareness. The FDA 
Office of Women’s Health launched the Pink Ribbon Sunday 
Mammography Awareness Program in 1998 to educate women 
about early detection of breast cancer through mammography. 
Pink Ribbon Sunday originally targeted African American and 
Hispanic churches. Over the years, the program’s outreach has 
expanded to connect with as many women as possible. Pink 
Ribbon events help educate women about the importance of 
mammograms and encourage them to take charge of their 
breast health by getting regular mammography screenings. We 
are pleased to share our updated mammography resource,  
P ink Ribbon Guide :  Mammography Matters 
https://www.fda.gov/media/157056/download?attachment 

Take Action 

This month and every month, there are 
many ways you can join the fight to save 
lives against breast cancer. Many women 
do not get their recommended  
mammography screenings due to fear, 
time, lack of knowledge about  
mammograms or concerns about cost. 
The Pink Ribbon Guide shares ways you 
can help make a difference including  
distributing reliable health information, 
providing emotional support and  

connecting women to local resources. In the guide, you will find: 

• Basic facts about mammography 

• Information on how to host an in-person or virtual event 

• A customizable flyer and postcard to promote your event 

• Resources on mammography and breast cancer 

Search for a certified mammography facility in your area. 
The Centers for Disease Control and Prevention (CDC) offers 
free or low-cost mammograms. Find out if you qualify. 

For resources and materials on other women's health  
topics, visit www.fda.gov/womens.  

Source: Adapted & reprinted from “Breast Cancer Awareness Month,” Knowledge 

and News on Women’s Health blog from FDA Office of Women’s Health- 

https://www.fda.gov/consumers/knowledge-and-news-women-owh-blog/breast-cancer-

awareness-month 

https://www.fda.gov/media/157056/download?attachment
http://www.fda.gov/womens
https://www.fda.gov/consumers/knowledge-and-news-women-owh-blog/breast-cancer-awareness-month
https://www.fda.gov/consumers/knowledge-and-news-women-owh-blog/breast-cancer-awareness-month
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• This tool adds length to lines and area/perimeter to  
polygons 

• The unit of measurement depends on the coordinate  
reference system (CRS): 

 WGS84 (Latitude/Longitude) → Square meters 

 State Plane Coordinates → Square feet 

• Convert to acres by dividing by: 

 4047 (for square meters) 

 43,560 (for square feet) 

For this example, the buffer area is 5.68 acres. 

METHOD 2: APPROXIMATE ESTIMATION 

A quicker estimation can be obtained using the Region of  
Influence routine accessible under the “Drainage Guidelines” 
heading on the main page of the Illinois Drainage Guide 
(Figure 4) 

Inputs Required.   

•  Cumulative tile length 

•  Recommended tile spacing 

•  Number of tile ends (excluding the outlet) 

•  Number of tile intersections 

•  Optional: Average angle of intersection (default is 90°) 

Results.   

The interface for the routine is shown in Figure 5. Using this 
method for the system in Figure 1, the estimated areas are: 

•  5.65 acres (assuming 90° intersections) 

•  5.59 acres (assuming 45° intersections) 

These estimates closely match the GIS-derived area of 5.68 
acres, validating the routine’s utility for quick assessments. 

CONCLUSION 

Both methods provide reliable estimates of the area influenced 
by irregular drainage systems. The GIS-based approach offers 
precision and spatial visualization, while the approximation 
method provides a fast and reasonably accurate alternative. 
Together, they offer valuable tools for engineers, contractors, 
and landowners managing non-patterned drainage systems.    

By Richard Cooke 

In 1995, I conducted a survey of Illinois Land Improvement  
Contractors Association (ILICA) members. At that time, only 
about 10% of tile drainage installations were patterned systems. If 
the survey were repeated in 2025, I suspect the situation would be 
reversed, with patterned systems dominating the landscape.  
Nevertheless, irregular drainage systems are still occasionally  
installed, particularly in 
fields with complex  
layouts or legacy  
infrastructure. 

Accurately estimating the 
area of influence of these 
systems is essential for 
evaluating drainage  
effectiveness, planning 
main tenance ,  and  
assessing environmental 
impact. This article  
presents two methods 
for such estimation,  
using the system shown in 
Figure 1 as a case study. 

METHOD 1: GIS-BASED ESTIMATE 

This method uses geographic information system (GIS)  
principles to calculate the area of influence of irregular tile 
drainage. The procedure is demonstrated using QGIS, a free 
and open-source platform, though similar steps apply in other 
GIS software. 

Step 1: Buffer Creation.  A buffer is created around each tile 
line using half the recommended lateral spacing. In QGIS, this 
is done via: 

Vector → Geoprocessing Tools → Buffer 

• Set buffer width to half the tile spacing 

• Disable overlap between individual line buffers 

• The buffer plugin interface and resulting region are shown 
in Figure 2.  

Step 2: Area Calculation. The area of the buffer region is 
calculated using: 

Vector → Geometry Tools → Add Geometry Attributes 
This manuscript was edited with assistance from Microsoft Copilot, an AI companion 
used to improve clarity, structure, and formatting. 

E S T I M A T I N G  AR E A  O F  I N F L U E N C E   
O F  I R R E G U L A R  DR A I NA G E  S Y S T E M S   

Figure 1.  Field with irregular 

drainage system  
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Figure 3. Add-Geometry-Attributes plugin menu. 

Figure 2. Buffer-Creation plugin menu and resultant buffer region.     

Figure 4. Location of Area of Influence Routine  

on the Main Page of the Illinois Drainage Guide.  

Figure 5. Interface 

for the Area of  

Influence Routine.  
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LICA R E C A L I B R A T I N G  F O R  G R E A T E R  S U C C E S S  

A popular Midwest tourist  

destination, Duluth, Minnesota, 

offered LICA members from 

across the nation a plethora of 

events and activities to partake in 

during their free time while  

attending the National LICA  

Summer Meeting in July: a tall ships 

festival, a high dive competition, 

the world’s largest rubber duck attraction, a car show, 3 blocks 

of street vendors, ore boat tours, and more! When indoors, 

members spared no time getting to business, committing 

meaningful time together to take a deeper dive into the broad 

range of factors, external and internal, that continually push 

and pull upon LICA, just like the ebb and flow of Lake  

Superior surrounding them, with the goal of recalibrating for 

even greater organizational success into the future. 

Held the week immediately following July 4th, attendance at 

the LICA Summer Meeting was strong. Whether for the  

respite from hotter weather at home or for the opportunity to 

engage leadership with their chapter’s concerns, members 

made the trek north prepared for a productive conference and 

looking forward to their time together with fellow members 

and friends. And the LICA Summer Meeting did not  

disappoint with plenty of discussion, reflection, and  

exploration occurring in meetings and hallways; plenty of  

social time with tours, hospitality hours, and free time activities 

galore. The take-home from the members present and their 

involvement at the conference was a recognition of change and 

a renewed sense of direction, spurred by open dialogue,  

transparency, and working together...the ebb and flow of any 

organization dedicated to long-term improvement and success. 

For more event details and the committee meeting reports,  be 

sure to vis it  Nat ional  LICA’s website at : 

https://www.licanational.com/meeting-minutes.   

 

https://www.licanational.com/meeting-minutes
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LICA O F F -R OA D  A DV E N T U R E  (LORA),  
M A K I N G  ME M O R I E S  OF F  T H E  B E A T E N  P A T H  

With the popularity of last year’s, first-ever LICA Off-Road 

Adventure, hosted by the Illinois & Indiana chapters, Illinois 

LICA’s picnic committee decided that the Badland’s Off-Road 

Park in Attica, IN would be a fun place to host this year’s  

picnic and members’ meeting; the same thoughts and approach 

of Indiana LICA last September. Extending the invite to our 

fellow LICA trail blazers in Indiana, a number of contractor 

members and their families converged to explore and tackle all 

the trails, terrain, and obstacles they could muster in one day 

before regrouping for a barbeque dinner and members’  

meeting held the last Saturday of July. 

The typical hot and humid weather of July didn’t seem to 

bother riders, drivers, or off-road rigs much with plenty of 

fresh mud holes, shaded timber trails, and cool creek bottoms 

to play around in. With more than 1400 acres of multi-

directional trails and diverse terrain including sand dunes, 

woods, gravel, mud, and rocks, the Badlands Off-Road Park is 

one of Indiana’s largest and most popular off-road parks for 

riders of all skill levels. For members new to the park, it’s 

quickly obvious that it can’t be fully explored in one day, so 

nearly all leave saying, “I’ll be back!” The park does such a 

great job of catering to off-roaders and their families, with 

camping and cabin rentals, side by side rentals, pay showers, a 

food shack, and parts and gift shops, that they make it easy to 

want to come back to continue the adventure and to forge 

more memories. And I am most happy to report (including for  

insurance reasons) that all that attended this year’s LICA Off-

Road Adventure will be more than capable of returning to the 

Badlands Off-Road Park whenever they feel! No serious 

breakdowns or injuries documented (not that you have to put 

yourself in those types of situations at the park, but we all 

know those individuals who can’t help themselves). 

Our sincere thanks to the Badlands Off-Road Park and Off 

The Trail Vacation Rentals & Campground teams for setting 

us up onsite and to our sponsors, Advanced Drainage Systems  

and Fratco, for helping make the event possible. To view all 

the pictures and videos from the event, visit our website: 

https://www.illica.net/picnics-gallery  

If you have any great ideas about other activities or events 

you’d like to see ILICA host, please reach out to the ILICA 

office, shoot us an email, or reach out to our picnic committee 

to share your thoughts. We’d love to hear them! 

https://www.illica.net/picnics-gallery
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Hickenbottom, Inc. . . . . . . . . . . . . . . . . . . . . . . . . . . .  

Martin Equipment of Illinois, Inc . . . . . . . . . . .  

Metal Culverts, Inc . . . . . . . . . . . . . . . . . . . . . . .   

Northland Trenching Equipment, LLC  . . . . . .  

Port Industries, Inc.  . . . . . . . . . . . . . . .  

Precision Intakes, Ltd . . . . . . . . . . . . . .  

Prins Insurance, Inc./United Fire Group . .  

Prinsco, Inc . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

Purple Wave Auction . . . . . . . . . . . . . . . . . . . . .  

River Valley Pipe, LLC . . . . . . . . . . . . . . . . . . . .  

Roland Machinery Co. . . . . . . . . . . . . . . . . . . . .  

Schlatter’s, Inc. . . . . . . . . . . . . . . . . . . . . . . . . . .  

Springfield Plastics, Inc. . . . . . . . . . . . . . . . . . . .  

Vermeer Midwest, Inc. . . . . . . . . . . . . . . . . . . . .  

Xylem, LTD. . . . . . . . . . . . . . . . . . . . . . . . . . . . .  
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CALENDAR OF EVENTS 
 

Illinois 

 

Area 3 Trap Shoot & Golf Outing  

September 12, 2025 

Kewanee, IL 

Izaak Walton Trap - Skeet Grounds:  9:00 am 

Baker Golf Course:  12:00 pm 
 

Register via QR code on page 20 

 

Board of Directors Meeting (hybrid) 

September 13, 2025 

Galva, IL 

Committee Meetings:  8 am - 12 pm 

Board Meeting:  1 pm 
 

In-person:  

ILICA Office: 112 Exchange St., Ste. 2, Galva, IL 61434 
 

Virtual: 

https://us02web.zoom.us/j/9759547353?pwd=c1ZPcjF
hSTBTYjhXeERNZnFRTXdOZz09 

Or call: 1-312-626-6799     Meeting ID: 975 954 7353 

Passcode: 0000 

 

Contractor Training Store & Illinois LICA 

Virtual Septic Training  

September 25, 2025 

8 - 11:30 am 

Register: https://form.jotform.com/210405973758159 

or via QR code on page 24 
 

 

https://us02web.zoom.us/j/9759547353?pwd=c1ZPcjFhSTBTYjhXeERNZnFRTXdOZz09
https://us02web.zoom.us/j/9759547353?pwd=c1ZPcjFhSTBTYjhXeERNZnFRTXdOZz09
https://form.jotform.com/210405973758159
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It’s OK  

Not to Be OK 

M e n t a l  H e a l t h 

Awareness Month, 

observed every May, 

(World Mental Health 

Day is Oct. 10th) 

serves as a crucial 

reminder that mental 

health is just as important as physical health. This national 

health observance is meant to raise awareness, reduce stigma 

and encourage individuals to seek help when needed. 

More than half of adults in the United States will experience 

mental illness—which refers to a variety of diagnosed  

conditions that affect one’s mood, behavior, feelings or  

thinking—at some point in their lives. Mental illnesses can  

occur occasionally, while others are chronic. The most  

common mental illnesses include anxiety disorder, major  

depression and bipolar disorder. However, roughly half of 

adults with mental illness in the United States don’t receive the 

treatment they need.  

Common barriers to receiving treatment include the high costs 

of and difficulty accessing mental health care, mental health 

professional shortages, and the stigma associated with mental 

health. When left untreated, mental health conditions can affect 

a person’s ability to manage both work and personal  

responsibilities. 

You Are Not Alone 

Mental health conditions are common, real and often treatable. 

Seeking help is a sign of strength, not weakness, so consider the 

following ways to gain mental health support: 

• Talk to someone you trust—a friend, mentor or family 

member—and share your feelings. 

• Use confidential 24/7 hotlines for immediate support. 

The SAMHSA’s National Helpline (1-800-662-HELP 

[4357]) is a treatment referral and information service. You 

can also call or text 988 for the 988 Suicide & Crisis  

Lifeline for yourself or others experiencing a mental health 

crisis. 

• Join support groups to gain a sense of community and 

understanding. 

• Practice self-care activities, such as exercise, healthy  

eating, quality sleep, mindfulness and hobbies. 

• Seek professional help from therapists, psychologists and 

psychiatrists to navigate mental health challenges. 

Most people experience mental health challenges at some point, 

and seeking help is a courageous—and critical—step toward 

recovery. 

4 Reasons Why Reading Is Good For Your Brain 

Reading is often considered a leisurely activity, but its benefits 

extend beyond entertainment. Daily reading can significantly 

impact mental health by enhancing cognitive function,  

reducing stress and fostering emotional well-being. Some 

health practitioners even pursue bibliotherapy—books used as 

a therapeutic tool—to support and treat individuals living with 

anxiety, depression and grief. 

Here are four reasons why incorporating reading into your 

daily routine helps your brain: 

) Cognitive stimulation—Regular readers are more likely 

to maintain their cognitive ability as they age. 

) Stress reduction—Reading for as little as six minutes can 

reduce stress by 68%. It can also be a healthy escape from 

daily stressors. You immerse yourself in a new world and, 

without visuals, can invent or visualize it yourself. 

) Improved focus—Reading requires concentration and 

attention to detail, which can improve one’s general ability 

to focus on tasks. 

) Social skill development—Frequent fiction readers  

often have better social ability and can easily empathize 

with others. 

While it’s clear that reading is beneficial, mental illness may 

impact one’s ability to read. If that’s the case, here are some 

tips for improving your relationship with reading: 

• Listen to audiobooks. Yes, listening to a book counts. 

Many people find it easier to process auditory words  

versus written words. 

• Select books you like. Don’t give in to pressure to read 

classic or new releases that people are talking about. Read 

the genres you actually enjoy. This can also keep you  

motivated. 

• Read short formats. If an entire book feels intimidating, 

opt for short stories, magazines or even interesting  

articles. Experiment with different formats to find what 

you like best. 

• Don’t pressure yourself. If your identity feels tied to 

reading or you’re worried about reading goals, let that self-

imposed pressure go and focus on other hobbies that 

bring you joy. 

Making reading a daily habit can yield many cognitive and 

emotional benefits. For further guidance, contact a mental 

health professional. 

SA F E T Y  F E A T U R E :  M E N TA L  HE A LT H  M I N U T E  

Source: Adapted from Mental Health Minute Newsletter - May 2025, 

Prins Insurance LICA Portal (Zywave) 
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